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[bookmark: _Toc23835252]ABSTRACT
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Consectetur libero id faucibus nisl tincidunt eget nullam non nisi. Pulvinar pellentesque habitant morbi tristique. Mauris cursus mattis molestie a iaculis. Donec massa sapien faucibus et molestie ac feugiat sed lectus. Lorem ipsum dolor sit amet consectetur adipiscing elit ut. Neque aliquam vestibulum morbi blandit cursus risus at ultrices. Elit pellentesque habitant morbi tristique. Fermentum posuere urna nec tincidunt. Eget sit amet tellus cras adipiscing enim.
Morbi tristique senectus et netus et malesuada. Mauris commodo quis imperdiet massa tincidunt. Tincidunt id aliquet risus feugiat in ante. Duis ut diam quam nulla porttitor massa id neque. Non sodales neque sodales ut etiam sit amet. Hac habitasse platea dictumst vestibulum rhoncus est pellentesque elit ullamcorper. Natoque penatibus et magnis dis parturient montes nascetur. Senectus et netus et malesuada fames. Sapien et ligula ullamcorper malesuada proin libero. Nulla facilisi cras fermentum odio eu feugiat pretium. Fames ac turpis egestas sed tempus urna. Eu nisl nunc mi ipsum faucibus. Sit amet purus gravida quis.
Commodo viverra maecenas accumsan lacus vel facilisis volutpat est velit. Amet purus gravida quis blandit turpis cursus in hac. Sagittis vitae et leo duis ut diam quam. Pulvinar elementum integer enim neque volutpat ac tincidunt. Volutpat consequat mauris nunc congue nisi vitae suscipit. Eget sit amet tellus cras. Metus aliquam eleifend mi in nulla posuere sollicitudin aliquam. Suspendisse faucibus interdum posuere lorem ipsum dolor sit amet consectetur.
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Symbol	Description	
		Angle of Attack
		Change in Coupler Angle


[bookmark: _Toc415853959][bookmark: _Toc419149472][bookmark: _Toc419149729][bookmark: _Toc419149930][bookmark: _Toc23835257]INTRODUCTION
[bookmark: _Toc23835258]USING THE DISSERTATION TEMPLATE
This is where the SECTION writing of the Publication Option begins, and it will be followed by a section conclusion after your PAPER writing. This section writing is required for the Publication Option, and it should broadly cover your overall research. This section writing should be able to stand alone and provide the reader an overview of your research in the event that any paper within the thesis/dissertation is removed. If you cite any sources within this section writing, they will appear in your Bibliography, which is separate from the references within your paper writing.
 Note that the capitalization of your headings should be identical in the Table of Contents (TOC), so be sure to type 1st level headings and 2nd level subheadings in all caps, or use the “Change Case” option under the Font group to change them to “UPPERCASE.” By default, Word’s spellcheck will ignore words in all caps, so go to File > Options > Proofing and make sure “Ignore words in UPPERCASE” is not selected.
This text and all text within the body of the T/D uses “Style Body Text,” which can be found on the Styles menu under the Home tab. You can click the dialog box launcher in the corner of the Styles group to view the full Styles menu. All headings, text, figure titles, and table titles within your document have been mapped to the Style formats and should be used throughout your T/D in order for the Table of Contents, figures, etc. to function correctly. 
[bookmark: _Toc23835259][bookmark: _Toc419149474][bookmark: _Toc419149731][bookmark: _Toc419149932]How to Use the Style Formats. 
 This is a 3rd level subheading and is indented 0.5 in. over from the left margin. This heading is NOT in all capital letters; instead, the first letter of each major word is capitalized. The paragraph text begins immediately after the heading.
Because Word wants to treat the entire line as Heading 3, formatting 3rd level headings properly takes an extra step. First, click the down arrow on your Quick Access Toolbar and select “More Commands.” In the drop-down menu, select “All Commands,” scroll down to “Style Separator,” and press “Add.” 
Now, type your 3rd level heading on a line by itself. Mark the heading as “Heading 3” in the Styles menu. With your cursor within the text of your heading, click the Style Separator tool in the Quick Access Toolbar, or press Ctrl + Alt + Enter. Your body text should be moved up to the same line as your heading, but it will not be treated as part of the heading and will not appear in your TOC. This is the way this template has formatted 3rd and 4th level headings.
The other way to work with 3rd level headings is to insert a carriage return at the end of the first line of the paragraph. This method requires more manual adjustment. If you format your 3rd level headings this way, the entire first line will appear in your TOC and the extra words will need to be removed. 
The styles to use for headings and titles are as follows: 
· Appendix Title (1): use for the title under “APPENDIX” if you only have one appendix. This title is optional. It will not appear in your TOC
· Appendix Title (2): if you have multiple appendices, use this for only the title on the appendices’ title pages so it will link to your TOC. You will need to add in the word “APPENDICES” and the corresponding letter (e.g., “A” and “B”) in your TOC
· HEADING 0: all headings in the front matter (i – ix) that appear in the TOC, and for the heading “Appendix” if you only have one appendix
· TOC Heading 1: only used for the “Table of Contents” heading to avoid having it appear within your TOC
· Heading 1: all major section headings, such as “INTRODUCTION” at the beginning of the current section
· Heading 2, Heading 3, etc.: all subsection headings follow in a like manner 
· Style Body Text: body text with a first-line indentation
· Normal: body text in the same paragraph as 3rd or 4th level headings (this style operates the same as Style Body Text, but does not have first line indentation)
· Figure Title: all figure captions 
· Table Title: all table titles 
· Paper Abstract: for the heading “Abstract” within your paper writing
· Paper Reference: for the heading “References” within your paper writing
· Paper Title: for your paper titles, with an uppercase Roman Numeral
· PAPER/SECTION Heading: use this for the word “PAPER” and “SECTION” at the start of your papers and section conclusion, but it will not link to the TOC
· Paper Authors: use if you list authors below paper title and before “ABSTRACT”
[bookmark: _Toc23835260][bookmark: _Toc419149475][bookmark: _Toc419149732][bookmark: _Toc419149933]How to Use the Table of Contents. 
 The table of contents, list of illustrations, list of tables, and nomenclature all work in a similar manner. The TOC is automatically generated and uses the styles mentioned above. They are already linked together, so once you input your own content, all you have to do is right-click in the TOC and click “Update Fields” (and “Update Entire Table” if prompted), and your headings and page numbers automatically appear. All you will need to do in your TOC is add in “SECTION,” “PAPER,” single-space multilined headings, and write “APPENDICES” and the corresponding letter if you have multiple appendices. 
If your line in the TOC is missing the dotted leader between the heading and the page number, put your cursor before the page number and hit the Tab key. This should move your page number over to the right margin and add the dotted leader.
The list of illustrations (LI) and list of tables (LT) work in a similar manner, except they use the styles “Figure Title” and “Table Title,” respectively. Again, to update these, you will have to right-click the table and click “Update Field.” You can leave the word “Figure” or “Table” at the start of each line or you can have the word appear above the list of numbers, but you should not have both. 
[bookmark: _Toc23835261]How to Add to the Nomenclature. 
[bookmark: _Toc419137169][bookmark: _Toc419142229][bookmark: _Toc523323110][bookmark: _Toc523382478][bookmark: _Toc523382672][bookmark: _Toc523382694][bookmark: _Toc523382720][bookmark: _Toc523383911][bookmark: _Toc523383987][bookmark: _Toc523383989][bookmark: _Toc523383992][bookmark: _Toc523386708][bookmark: _Toc523387038] The nomenclature section is updated the same way as the TOC. However, to get a symbol to be added to the nomenclature, you must add a Field before the symbol. For example, suppose you wanted the symbol 	 to be added to the nomenclature. First, turn on the Show/Hide Paragraph button in the upper right corner of the Paragraph group in the Home tab. Then, press Ctrl + F9 to open up a Field tag. Inside the Field tag, you will type in the following:
{ TC “	Description Goes Here” \n \f NOM }
where inside the quotation marks,  is your symbol, followed by a tab and your description of the symbol. After the closing quotation mark, \n is used to suppress page numbers, and \f NOM links the entry to your nomenclature. 
Try it out yourself by adding an entry for φ as “Golden Ratio Constant” and then updating the nomenclature section. If done correctly, the new entry should be added between  and .
[bookmark: _Toc419142230][bookmark: _Toc523323111][bookmark: _Toc523382479][bookmark: _Toc523382673][bookmark: _Toc523382695][bookmark: _Toc523382721][bookmark: _Toc523383912][bookmark: _Toc523383988][bookmark: _Toc523383990][bookmark: _Toc523383993][bookmark: _Toc523386709][bookmark: _Toc523387039]The other way to insert a Field tag is to go to Insert > Quick Parts > Field. Then, in the Field Names box, scroll down and select TC, type the description for your symbol in the Text Entry box, check “Supresses page numbers,” and press OK.” After this, you will still need to define your symbol and link it to your nomenclature. Turn on the Show/Hide button, then type your symbol inside your opening quotation mark and press the tab button once. Then, add \f NOM to the end of the entry. For example, show the codes on this: 	.
The spacing in your nomenclature will need to be manually adjusted to be fully correct. When adjusting tabs and spacing, make sure your changes are not being linked to your TOC. 
[bookmark: _Toc23835262][bookmark: _Toc419149476][bookmark: _Toc419149733][bookmark: _Toc419149934]Formatting Figures. 
 Figures should be formatted with the same amount of space above and below the actual figure (two carriage returns with double spacing). The title should be below the Figure. In your SECTION writing, the caption is designated as “Figure x.y” or “Figure x.y.” where x is the number of the main section that the figure is in and y is the number of the figure in that section. For example, Section 1 could have Figures 1.1, 1.2, and 1.3. Then, Section 2 could have 2.1, 2.2, 2.3, and 2.4. Refer to figures like this: “Figure 1.1 and 1.2 illustrate a classic four-bar linkage where R1 is the ground link.” Titles and captions should be identical in the main body and in the LI/LT. If your figure has multiple parts (such as a, b, etc.), you can include a common title before the individual descriptions in your main body and then use only the common title in your LI/LT.


[bookmark: _Toc21330565]Figure 1.1. Example four-bar linkage.

[bookmark: _Toc23835263]Formatting Equations. 
 Equations should be numbered throughout the T/D and should have one blank line before and after (one carriage return with double line spacing). Best practice is to introduce your equations before they appear, such as in Equation (1) and (2):

			(1)

			(2)
If your next line under an equation is a new paragraph, it should be indented. If it is within the same paragraph or the sentence continues after the equation (most commonly starting with “where”), then the line should not be indented.
[bookmark: _Toc23835264][bookmark: _Toc419149477][bookmark: _Toc419149734][bookmark: _Toc419149935]Formatting Tables. 
 Tables are formatted in much the same way as figures. The title is placed at the top, and an extra line of space is used above and below. Do this by inserting two carriage returns above and below, and add in 12 pt of “Before” paragraph spacing in the line below the table unless it comes before a 2nd level heading. The numbering of tables in the SECTION writing follows the same rules as the figures. Table 1.1 is one such example.



[bookmark: _Toc21330566]Figure 1.2. Four-bar linkage – crossed configuration.

[bookmark: _Toc419149151][bookmark: _Toc21330714]Table 1.1. Original STATUS array for example mechanism.
	
	Loop #
	Vector numbers

	
	
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Mag
	1
	0
	0
	0
	0
	9
	9
	9
	9
	9
	9
	9
	9

	Dir
	1
	1
	1
	1
	0
	9
	9
	9
	9
	9
	9
	9
	9

	Mag
	2
	9
	9
	9
	9
	0
	0
	1
	0
	9
	9
	9
	9

	Dir
	2
	9
	9
	9
	9
	1
	1
	0
	0
	9
	9
	9
	9

	Mag
	3
	0
	9
	9
	9
	9
	9
	9
	9
	0
	0
	1
	0




[bookmark: _Toc419149478][bookmark: _Toc419149735][bookmark: _Toc419149936][bookmark: _Toc23835265]MORE EQUATIONS AND FIGURES
New example equations are shown below. They are Equations (3) and (4):

				(3)

				(4)
this line continues the sentence, where you will normally define the symbols that you used within your equations, so the first word is not capitalized or indented.
Shown below is Figure 1.2. Make sure that your punctuation and capitalization within your figure captions is consistent. If you decide to end your captions with a period, make sure to do so with all of them.


[bookmark: _Toc21330567]
Figure 1.3. Example mechanism.

[bookmark: _Toc23835266]TIPS AND TRICKS FOR FORMATTING
This section will review helpful tips and tricks when using this template in order to achieve proper formatting. Note that this template was created for Word 2016; other versions of Word might vary.
[bookmark: _Toc23835267]Show/Hide Button. 
 The Show/Hide button (¶) is located under the Home tab in the top right corner of the Paragraph group. This button will allow you to see non-printing characters such as spaces, tabs, carriage returns, and page breaks. If you are having formatting issues, turning on this button will help you identify the problem.
[bookmark: _Toc23835268]Spell Check. 
 Be sure to check the spelling and grammar in your document periodically. If this is not turned on automatically, you can click on “Spelling & Grammar” under the Review tab to launch a review. 
To change or update the settings of Word’s Spell Check, go to File > Options > Proofing. Make sure “Ignore words in UPPERCASE” is turned off so that Word will still check the spelling in your headings. In the Proofing dialog box, you can also click on “Settings” next to “Writing Style” and select additional areas of grammar and style for Word to check.   
[bookmark: _Toc23835269]Miscellaneous. 
 While writing and formatting your document, the following is recommended:
· Save your document often and back up with multiple files.
· Set your text to “Left Align.” Justified text is accepted, but will often lead to more formatting problems.
· Check your headings periodically. Make sure the numbering and the formatting for all of them is correct and consistent. 
For more information on single-spacing headings, see Section 3. For information on how to use landscape pages for large tables or figures, see Appendix B.
[bookmark: _Toc23835270]Checklist. 
 Be sure to check the following items before submitting a new version for format checking:
· Heading numbers are bold.
· “SECTION” and “APPENDICES” are written into your TOC.
· Page numbers and headings in TOC have been updated.
· Capitalization and punctuation are consistent in all figures and tables.
· Spacing above and below figures and tables is consistent. If your figure is right before a 2nd level heading, you may need to move your cursor to the blank line after the figure and change that line to single spacing.
This is not an exhaustive list. Please refer to the official Missouri S&T Thesis & Dissertation Specifications for a full list of formatting requirements. If you are having problems with the templates, refer the user guide on Graduate Studies’s website. 



[bookmark: _Toc23835271]LITERATURE REVIEW

This section is recommended but not required.
Lorem ipsum dolor sit amet, consectetur adipiscing elit. In viverra ornare purus eget lacinia. Fusce ultricies quam condimentum, convallis lectus quis, rhoncus mi. Suspendisse congue placerat massa a ullamcorper. Vivamus non nibh nec nibh accumsan placerat ut quis velit. Ut congue, tellus nec ultricies sodales, mi mauris congue elit, consequat accumsan leo est quis justo. Etiam vel odio ac velit fermentum sodales eget at magna. Mauris arcu magna, semper id eleifend a, vulputate vitae orci. Donec vel dolor luctus, sollicitudin nulla ut, dapibus nibh. Suspendisse potenti. Vivamus interdum tellus eget massa volutpat ullamcorper. Phasellus vitae urna libero.
[bookmark: _Toc23835272]CATEGORY ONE
Vestibulum et nunc aliquam, tempus ligula id, viverra nisi. Morbi iaculis ut orci vitae lacinia. Integer hendrerit, est sit amet viverra mattis, enim libero dictum neque, et euismod libero est sed justo. Phasellus consequat, leo sit amet suscipit venenatis, sapien tortor vehicula dolor, at blandit risus enim non dui. Maecenas ut odio nunc. Sed vitae ipsum est. Fusce efficitur neque vitae erat fermentum efficitur. Integer sed feugiat metus. Proin vestibulum libero quis lacus pharetra, fringilla vulputate libero molestie. Etiam ac risus ut lorem sagittis laoreet. Aliquam at diam id neque pretium dapibus ac id nisi. Maecenas non auctor erat. Donec volutpat malesuada placerat. Sed pulvinar erat vestibulum, placerat urna nec, maximus nisl. 

Praesent facilisis, felis a posuere rhoncus, lorem tortor euismod lectus, in commodo quam orci sed mi. Duis vel justo vestibulum, accumsan risus in, vestibulum eros. Integer pharetra, metus at blandit malesuada, nisi nibh tempus nunc, eu malesuada dui lectus quis quam. Donec quis vulputate diam. Proin tincidunt convallis est et accumsan. Sed vel posuere odio. Ut fermentum, justo sed dignissim gravida, quam arcu pulvinar nisi, eget feugiat odio purus et erat. Morbi aliquet viverra sapien, non auctor sem facilisis non. Aliquam vehicula arcu efficitur, tincidunt nisl commodo, feugiat erat. Cras et eros metus. Aenean in efficitur tortor. Nam ac porttitor leo. Vivamus ac odio eu nisi interdum tincidunt vitae ac sem. Suspendisse vitae rutrum risus. Cras volutpat sem velit, sit amet tincidunt massa dictum nec.
[bookmark: _Toc23835273]CATEGORY TWO
Praesent facilisis, felis a posuere rhoncus, lorem tortor euismod lectus, in commodo quam orci sed mi. Duis vel justo vestibulum, accumsan risus in, vestibulum eros. Integer pharetra, metus at blandit malesuada, nisi nibh tempus nunc, eu malesuada dui lectus quis quam. Donec quis vulputate diam. Proin tincidunt convallis est et accumsan. Sed vel posuere odio. Ut fermentum, justo sed dignissim gravida, quam arcu pulvinar nisi, eget feugiat odio purus et erat. Morbi aliquet viverra sapien, non auctor sem facilisis non. Aliquam vehicula arcu efficitur, tincidunt nisl commodo, feugiat erat. Cras et eros metus. Aenean in efficitur tortor. Nam ac porttitor leo. Vivamus ac odio eu nisi interdum tincidunt vitae ac sem. Suspendisse vitae rutrum risus. Cras volutpat sem velit, sit amet tincidunt massa dictum nec.
In non purus ut lectus condimentum gravida, Figure 2.1. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Sed ac ex justo. Pellentesque vehicula, lectus non tempor gravida, quam nibh scelerisque est, non pulvinar nisl erat in ipsum. Ut consequat tristique metus, a efficitur dui mattis eget. Praesent eu volutpat diam, vitae sodales nibh. Maecenas in libero sit amet massa finibus egestas at quis turpis.

[image: ]
[bookmark: _Toc21330568]Figure 2.1. The is the first figure under the second 1st level heading in your section writing. Note that the numbering for figures and tables in your section writing differs from the figures and tables in your paper writing.

Duis bibendum purus nulla, in pretium diam dapibus eu. Curabitur dolor libero, ullamcorper tempor nisi eu, vehicula hendrerit lacus. Vestibulum scelerisque velit quis sagittis tempor. Quisque elit erat, ultrices quis sapien sit amet, dapibus suscipit nulla. Duis eu turpis orci. Proin sit amet sapien non nibh hendrerit venenatis et quis ipsum. Duis euismod velit lacus. Suspendisse eget arcu at dui eleifend pharetra at id ligula.
[bookmark: _Toc419149479][bookmark: _Toc419149736][bookmark: _Toc419149937]

PAPER
[bookmark: _Toc23835274]TITLE OF FIRST PAPER THAT WILL BE SINGLE SPACED IF IT IS LONGER THAN ONE LINE AND IT WILL BE NUMBERED WITH AN UPPERCASE ROMAN NUMERAL
[bookmark: _Toc23835275]ABSTRACT
This is where you will insert text from your published papers or papers intended for publication. Formatting in the PAPER writing differs from the SECTION writing. The word “PAPER” should appear at the top of the page of the first paper. You can use the PAPER/SECTION Heading style for this, but it will not appear in the TOC (you must write it in manually, along with “SECTION” before your document’s introduction and conclusion. Use the styles “Paper Title,” Paper Abstract,” and “Paper References” within your PAPER writing so that they will appear in your TOC appropriately. You may use the same styles for Heading 1–4 that you would use in your SECTION writing.
The numbering within your PAPER writing will restart with each paper. To do this, right-click the number in front of your 1st level heading and select “Restart at 1.” The rest of your heading numbers should change automatically.
Note that the 1st level headings within your PAPER writing do not need to start on a new page like they do in your SECTION writing, but you still need to make sure they have the same amount of space above and below (insert two carriage returns before typing your 1st level heading).
The figures and tables within your PAPER writing will be numbered consecutively (e.g., Figure 1, Figure 2) regardless of which section of the paper they appear in, and the numbering will restart with each paper.
Finally, the heading titles shown in this template are for visual aid only. The title of your headings should match your published paper.

1. [bookmark: _Toc23835276]INTRODUCTION
[bookmark: _Toc419149480][bookmark: _Toc419149737][bookmark: _Toc419149938][bookmark: _Toc23835277]THIS IS A SECOND LEVEL SUBHEADING
The following paragraphs demonstrate how to use a citation and a footnote. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras imperdiet non nisl et consequat. Donec ac ligula velit. Donec et erat bibendum, aliquam justo vitae, condimentum sem. Donec sit amet quam eu nisi viverra maximus nec eget lectus. In non purus ut lectus condimentum gravida. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Sed ac ex justo. Pellentesque vehicula, lectus non tempor gravida, quam nibh scelerisque est, non pulvinar nisl erat in ipsum. Ut consequat tristique metus, a efficitur dui mattis eget. Praesent eu volutpat diam, vitae sodales nibh. Maecenas in libero sit amet massa finibus egestas at quis turpis.
Donec rhoncus pretium enim, vel malesuada dui feugiat et. Etiam ultricies vel nunc ut venenatis.[footnoteRef:1] The footnote is at the bottom of this page. Duis bibendum purus nulla, in pretium diam dapibus eu. Curabitur dolor libero, ullamcorper tempor nisi eu, vehicular. [1:  Here’s the text of the footnote.] 

[bookmark: _Toc419149481][bookmark: _Toc419149738][bookmark: _Toc419149939][bookmark: _Toc23835278]THIS IS ANOTHER SECOND LEVEL SUBHEADING
 Note that there will always be an extra line of space before 2nd level headings. This section contains Figure 1, reflecting the first figure in the first paper. 


[bookmark: _Toc21330569]
Figure 1. Vector loop decomposition of loop 1.

This is the next line after Figure 1. Keep in mind that you should have the same space above and below a figure, and your page should not begin or end in an orphan line.
[bookmark: _Toc23835279][bookmark: _Toc419149482][bookmark: _Toc419149739][bookmark: _Toc419149940]Third Level Heading. 
[bookmark: _Toc522879335] This is the first 3rd level heading of Section 2. Note the difference between this and the others. Remember that when you unbold the first line of your paragraph next to a 3rd or 4th level heading, do not highlight the last space, otherwise your heading number will be unbolded. If this happens, turn on the Show/Hide button, highlight the paragraph symbol at the end of the first line, and press bold. If this does not work, click on the number and change the entire first line back to your heading style, then try again to remove the bold on the first sentence. 
[bookmark: _Toc23835280]Another Third Level Heading. 
[bookmark: _Toc522879337] This is the second 3rd level heading of Section 2. Remember that the first letter of every major word and any proper nouns (such as names of people or places) of a 3rd level heading is capitalized.
The second figure will be named Figure 2 no matter where it appears within the first paper. The first table will be Table 1 no matter where it appears within the paper.

[image: ]
[bookmark: _Toc21330570]Figure 2. Caption of the second figure in this paper goes here. Make sure that your figures are consistently aligned, either all left-aligned or all centered.

[bookmark: _Toc23835281][bookmark: _Toc419149483][bookmark: _Toc419149740][bookmark: _Toc419149941]Fourth level heading. 
 This is the first 4th level heading of Section 2. Note the difference between this and the others. Only the first letter of the first word of the heading and any proper nouns (such as names of people or places) are capitalized in a 4th level heading.  

[bookmark: _Toc21330715]Table 1. The title of your first table in your first paper goes here. Make sure your punctuation and capitalization of all table titles is consistent.
	
	
	
	
	

	
	
	
	
	



[bookmark: _Toc23835282]Another fourth level heading. 
 This is the second 4th level heading of Section 2. Subheadings beyond the 4th level should be avoided, and bullet points used instead. Section 3 demonstrates how to format titles that are longer than one line and how they should appear in the TOC.

1. [bookmark: _Toc23835283]THIS IS SECTION THREE WITH A VERY LONG HEADING THAT NEEDS TO BE SINGLE SPACED
1.1. [bookmark: _Toc23835284]HOW TO SINGLE-SPACE FIRST LEVEL, SECOND LEVEL, AND THIRD LEVEL HEADINGS
Your 1st level headings should automatically be single spaced if they are more than one line long. To single-space a 2nd level heading, highlight the heading and change to single line spacing. Then, place your cursor at the end of the last line of the heading and add 12 pt of “After” paragraph spacing. Then, use the ruler to make sure your second line is properly aligned under the text of first line. 
[bookmark: _Toc23835285][bookmark: _Toc419149487][bookmark: _Toc419149744][bookmark: _Toc419149945]Third Level Heading. 
 Mauris faucibus, turpis vitae maximus imperdiet arcu velit iaculis libero, eu vestibulum sem velit vitae enim. Pellentesque lacus ex, lobortis a congue sit amet, vulputate eu velit. 
[bookmark: _Toc23835286][bookmark: _Toc419149488][bookmark: _Toc419149745][bookmark: _Toc419149946]Another Third Level Heading that Demonstrates Spacing of a Very Long Title. 
 Note that long titles for 3rd and 4th level headings are kept double spaced in text but are still single spaced within the TOC. This subsection also contains Table 2.

[bookmark: _Toc21330716]Table 2. The table title of your second table in your first paper.
	
	
	
	
	

	
	
	
	
	

	
	
	
	
	



[bookmark: _Toc23835287][bookmark: _Toc419149489][bookmark: _Toc419149746][bookmark: _Toc419149947]Fourth level heading. 
 Sed et dui a odio pharetra tempor aecenas pretium, erat vulputate ullamcorper malesuada, ex erat auctor mi, ut pharetra leo velit eget nisi. Mauris consequat at ante at pellentesque. Proin dignissim ipsum in orci laoreet, a pharetra nunc consequat. Nam quis lacinia neque. Sed et felis mauris. Fusce tempor semper tincidunt. Phasellus vehicula mauris vel purus gravida fermentum. Etiam tincidunt consectetur sagittis.
Fusce nec diam eu felis maximus ultrices. Quisque suscipit mollis nunc id iaculis. Fusce ut iaculis risus. Pellentesque laoreet risus a neque lacinia, ut vestibulum erat lobortis. Integer scelerisque fermentum nulla sed molestie. Sed eu ex vitae ex sollicitudin efficitur. Pellentesque hendrerit non mi quis condimentum.
[bookmark: _Toc23835288]Another fourth level heading.
 In varius molestie leo massa lobortis donec suscipit, mi vel hendrerit dignissim, purus turpis euismod turpis, sodales. Duis bibendum purus nulla, in pretium diam dapibus eu. Curabitur dolor libero, ullamcorper tempor nisi eu, vehicula hendrerit lacus. Vestibulum scelerisque velit quis sagittis tempor. Quisque elit erat, ultrices quis sapien sit amet, dapibus suscipit nulla. 
Duis eu turpis orci. Proin sit amet sapien non nibh hendrerit venenatis et quis ipsum. Duis euismod velit lacus. Suspendisse eget arcu at dui eleifend pharetra at id ligula. Phasellus eget quam auctor, finibus libero a, ultricies tortor. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam ullamcorper porta ultricies.
1.2. [bookmark: _Toc23835289]ANOTHER SECOND LEVEL HEADING
It is important to remember never to have a Section 1 without a Section 2. Thus, you should not have Section 3.1 without also having Section 3.2. 
The captions of tables with titles that are more than one line long should be single spaced, as shown in Figure 3.

[bookmark: _Toc21330571]Figure 3. Example of a figure with multiple parts and a very long title that takes up more than one line. a) Caption for Part A goes here. b) Caption for Part B goes here. c) Caption for Part C goes here. d) Caption for Part D goes here.
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[bookmark: _Toc23835291]SECOND PAPER TITLE HERE AND IT SHOULD BE SINGLE SPACED IF IT IS MORE THAN ONE LINE LONG

Student Name, Joe Smith, James B. Brown, Charles R. Jones, D. F. Lang, and Hardy Davidson
Deparment of Mechanical and Aerospace Engineering, Missouri University of Science and Technology, Rolla, MO 65409
[bookmark: _Toc23835292]ABSTRACT
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Integer iaculis volutpat mattis. Quisque sodales consequat nibh. Phasellus aliquam, erat sit amet ullamcorper laoreet, nibh risus vulputate ante, sit amet fringilla quam mauris eu dui. Ut eget viverra dui. Aenean tortor metus, vehicula in blandit id, tincidunt vitae velit. Maecenas ullamcorper dictum condimentum. Suspendisse id feugiat sapien, sit amet tempor nibh. Fusce in est ipsum. Proin rhoncus risus nec gravida finibus. Nunc lobortis purus eu mauris laoreet convallis. Vestibulum at luctus ex. Maecenas arcu ante, bibendum vel pellentesque non, hendrerit sed nisi. Praesent eget nisi nisi. Phasellus euismod libero in sapien tincidunt imperdiet. Sed nec sollicitudin eros. Vestibulum sit amet dignissim.

2. [bookmark: _Toc23835293]INTRODUCTION

Aliquam tempor, mauris id feugiat accumsan, leo mi molestie tellus, nec interdum nunc justo tristique nisi. Etiam ac efficitur eros. Sed nec vulputate diam. Donec ac leo et ligula aliquam eleifend. Sed tincidunt odio ut metus efficitur, sit amet sodales orci pretium. Praesent sagittis suscipit erat porta consectetur. Aenean cursus quam fermentum, auctor mauris ut, sodales libero. Proin accumsan lacinia orci, non egestas lorem euismod eu. Maecenas arcu ante, bibendum vel pellentesque non, hendrerit sed nisi. Aenean tortor metus, vehicula in blandit id, tincidunt vitae velit.
Nunc nibh odio, efficitur in gravida vel, scelerisque quis eros. Integer cursus aliquam libero, a condimentum elit finibus in. Suspendisse commodo justo orci, ac lacinia nisi posuere eu. Pellentesque porta sem non leo mollis interdum. Nunc vulputate nunc quis magna hendrerit cursus. Maecenas consequat non purus sit amet aliquet. In ultrices augue et leo imperdiet vulputate. Phasellus eleifend vestibulum elit non venenatis. Phasellus consequat iaculis suscipit.
[bookmark: _Toc23835294]BACKGROUND
Nunc nibh odio, efficitur in gravida vel, scelerisque quis eros. Integer cursus aliquam libero, a condimentum elit finibus in. Suspendisse commodo justo orci, ac lacinia nisi posuere eu. Pellentesque porta sem non leo mollis interdum. Nunc vulputate nunc quis magna hendrerit cursus. Maecenas consequat non purus sit amet aliquet. In ultrices augue et leo imperdiet vulputate. Phasellus eleifend vestibulum elit non venenatis. Phasellus consequat iaculis suscipit.
Morbi mollis condimentum maximus. Etiam hendrerit commodo sapien nec mattis. Aliquam quis tortor finibus, molestie dui ac, luctus erat. Nulla massa lacus, finibus at convallis et, congue ac tellus. Sed vulputate magna eget lectus congue, vel fringilla ipsum sodales. Proin finibus augue velit, id vestibulum libero malesuada sit amet. Donec sodales sapien vitae mauris posuere laoreet. 
[bookmark: _Toc23835295]OBJECTIVES
Nunc nibh odio, efficitur in gravida vel, scelerisque quis eros. Integer cursus aliquam libero, a condimentum elit finibus in. Suspendisse commodo justo orci, ac lacinia nisi posuere eu. Pellentesque porta sem non leo mollis interdum. Nunc vulputate nunc quis magna hendrerit cursus. Maecenas consequat non purus sit amet aliquet. In ultrices augue et leo imperdiet vulputate. Phasellus eleifend vestibulum elit non venenatis. Phasellus consequat iaculis suscipit.
[bookmark: _Toc23835296]Third Level Heading. 
Donec gravida lacus sit amet lorem viverra, nec imperdiet velit imperdiet. Morbi quis justo ac dui pulvinar efficitur. Nulla non rhoncus purus. Quisque vehicula bibendum sapien, sed mollis quam aliquam eu. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; Ut eros augue, consectetur vel bibendum vitae, fermentum a neque. Donec dolor tortor, ornare in pretium non, rutrum in lacus. Vivamus lorem nunc, tempor in aliquam eget, sodales a libero. Phasellus vel enim sed purus varius ornare. Fusce sollicitudin elit purus, ut rutrum nunc pharetra sed. Praesent rutrum vulputate tempus.
[bookmark: _Toc23835297]Fourth level heading. 
Etiam elementum, metus quis hendrerit laoreet, velit purus pulvinar lectus, quis rutrum arcu risus sed justo. Sed tincidunt dolor vel leo suscipit pharetra. Curabitur quis risus a purus volutpat iaculis. In hac habitasse platea dictumst. Aliquam erat volutpat. Maecenas eget cursus orci. Suspendisse ut erat felis. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Mauris sollicitudin ut diam in lobortis. Quisque euismod luctus lorem, id maximus ex efficitur quis.
[bookmark: _Toc23835298]Second fourth level heading. 
 Quisque consectetur ac metus id placerat. Praesent facilisis est non risus posuere tempus. Proin maximus, ante vel pulvinar suscipit, nisl nulla dictum velit, eu vulputate nulla leo ac massa. Nulla lacinia semper orci eget commodo. Donec eleifend urna rutrum, pellentesque neque sit amet, pharetra eros. Maecenas egestas purus eu leo interdum, eget faucibus mauris rutrum. In hac habitasse platea dictumst. Ut in velit lobortis, dictum nisl non, hendrerit ante. Phasellus lacinia diam sit amet consequat malesuada. Fusce volutpat, neque a pellentesque mattis, leo dolor dictum turpis, non elementum lacus odio ut dui. Nunc sapien arcu, rutrum vel iaculis in, lacinia nec enim. Aliquam diam felis, semper aliquet dolor eget, varius.
[bookmark: _Toc23835299]Second Third Level Heading. 
 Phasellus malesuada lobortis blandit. Vestibulum posuere, magna nec imperdiet gravida, nunc nisi tincidunt ante, ac consectetur odio justo ac purus. Etiam et fermentum sem. Sed at massa molestie mauris aliquam posuere. Morbi tincidunt finibus elementum. Proin placerat tellus at magna euismod fermentum. Nam sagittis porttitor efficitur. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; Pellentesque vel tristique nulla, non finibus leo. Aliquam eget egestas tellus. Fusce tempus iaculis ipsum in bibendum. Fusce id libero eu diam varius sodales. Morbi id enim pharetra, bibendum est ac, varius nulla.
[bookmark: _Toc23835300]RESEARCH SCOPE
Proin hendrerit, felis sit amet venenatis mattis, magna orci maximus lacus, a mattis eros lacus vel arcu. Maecenas nulla mauris, sollicitudin ut erat pharetra, efficitur pharetra urna. Sed ultricies nunc sit amet dolor tempus efficitur. Pellentesque eget elit non lacus scelerisque porta. Donec feugiat faucibus rhoncus. Maecenas porttitor lectus ut eros imperdiet, in facilisis nulla dignissim. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Ut nec erat sit amet odio ullamcorper.

[bookmark: _Toc23835301]METHODOLOGY
[bookmark: _Toc23835302]MATERIALS
Quisque consectetur ac metus id placerat. Praesent facilisis est non risus posuere tempus. Proin maximus, ante vel pulvinar suscipit, nisl nulla dictum velit, eu vulputate nulla leo ac massa. Nulla lacinia semper orci eget commodo. Ut in velit lobortis, dictum nisl non, hendrerit ante. Phasellus lacinia diam sit amet consequat malesuada. 
Below is Figure 1, the first figure in the second paper. Figure numbering restarts within each paper. The numbers do not correspond with section number.

[image: ]
[bookmark: _Toc21330572]Figure 1. Title of the first figure in the second paper goes here. Notice that the figure numbers in your paper writing are always consecutive, no matter where they appear within the paper. Therefore, this is “Figure 1” just like in your first paper even though it appears under Section 2 in your second paper.

Phasellus malesuada lobortis blandit. Vestibulum posuere, magna nec imperdiet gravida, nunc nisi tincidunt ante, ac consectetur odio justo ac purus. Morbi tincidunt finibus elementum. Proin placerat tellus at magna euismod fermentum. Nam sagittis porttitor efficitur. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; Pellentesque vel tristique nulla, non finibus leo. 
[bookmark: _Toc23835303]PROCEDURE
Proin hendrerit, felis sit amet venenatis mattis, magna orci maximus lacus, a mattis eros lacus vel arcu. Maecenas nulla mauris, sollicitudin ut erat pharetra, efficitur pharetra urna. Sed ultricies nunc sit amet dolor tempus efficitur. Maecenas porttitor lectus ut eros imperdiet, in facilisis nulla dignissim. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Ut nec erat sit amet odio ullamcorper ultrices. Maecenas at lorem nisi. Proin luctus ipsum nisl, eleifend sollicitudin quam vulputate eget. 
Table 1 is the first table in the second paper.

[bookmark: _Toc21330717]Table 1. Table title goes here.
	
	
	

	
	
	

	
	
	



Nam pharetra tellus tincidunt, tempor tortor vitae, aliquam massa. Curabitur ultrices nibh id erat bibendum elementum ut et diam. Mauris rhoncus, libero eget vehicula feugiat, nunc magna porta erat, vel consectetur est ex malesuada nunc. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; Mauris faucibus nisi ac nulla ornare bibendum. Nam condimentum tristique sollicitudin. In pretium condimentum magna, id porta ex tristique in. Cras et vehicula metus. Duis finibus nulla ac dictum tristique. Curabitur condimentum ex sollicitudin, pellentesque tortor id, accumsan elit. Mauris pellentesque, risus a bibendum suscipit, magna metus iaculis mi, ac vulputate felis magna ac mi.
Morbi feugiat nibh id nulla laoreet, a mollis mauris blandit. Ut at nunc justo. Vestibulum lacinia dolor quis tellus mattis, vel convallis enim ultricies. Duis sed lectus ultrices, sollicitudin magna at, dignissim ante. In et nibh euismod, dignissim purus at, finibus enim. Quisque tortor augue, molestie at nisl nec, dapibus condimentum nibh. Aenean eget sem quis lorem imperdiet varius. Nam vulputate ultricies ipsum, nec tincidunt urna facilisis in. Nunc pellentesque imperdiet molestie. Integer vestibulum sem nisl, in volutpat lectus hendrerit ut. Proin malesuada volutpat lacinia. Donec porttitor, dolor eget rutrum vehicula, dolor nisl tristique nisi, eget posuere arcu dui ut metus. Nulla eget lectus congue, suscipit lectus vel, elementum lectus.

[bookmark: _Toc23835304]RESULTS
[bookmark: _Toc23835305]FIRST HEADING OF RESULTS
Pellentesque nec sodales nunc. Suspendisse felis nunc, feugiat vel sapien non, sollicitudin mattis ligula. Vivamus id luctus risus. Maecenas vestibulum ligula nec nibh vehicula, sit amet lobortis velit mattis. Praesent luctus congue elit sed posuere. Nullam orci lectus, ullamcorper ut facilisis aliquet, placerat nec dolor. Vestibulum ullamcorper mi eu purus condimentum, vitae tempus arcu convallis. Aenean cursus ante ac turpis mollis vehicula. Sed lobortis posuere nisi ut accumsan. Morbi nibh purus, tempus a maximus quis, efficitur id enim, as shown in Table 2.

[bookmark: _Toc21330718]Table 2. Table title goes here and if it spans more than one line it should be single spaced within.
	
	
	

	
	
	

	
	
	



Phasellus non faucibus urna. Etiam posuere fringilla erat non ultrices. Quisque et turpis sem. Nullam dignissim felis ut aliquet iaculis. Aliquam ac sem et justo sodales cursus. Integer varius ultrices ultricies. Integer at leo quis nunc ullamcorper vulputate. Proin erat metus, tincidunt tincidunt convallis eu, ultrices euismod enim. In hac habitasse platea dictumst. Vivamus cursus id metus vel congue. Pellentesque tortor lorem, sagittis non ultricies eu, euismod id nunc. Donec fermentum tempus arcu, non porttitor ligula finibus rhoncus. Maecenas id dolor sed ex pellentesque laoreet et sollicitudin ipsum. Nulla sagittis elit ut eros pharetra sagittis.
[bookmark: _Toc23835306]SECOND HEADING OF RESULTS
Etiam viverra cursus facilisis. Sed aliquet justo id fermentum vehicula. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Aenean porttitor tortor lacus, posuere molestie enim ultrices vel. Integer eu varius risus. Vivamus gravida ipsum non lorem varius vulputate. Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Morbi lorem metus, fringilla facilisis pharetra a, ultrices a arcu. Nullam sed eros ante. Cras egestas egestas scelerisque. In rutrum enim non ante efficitur, ullamcorper bibendum nisl lacinia. Nulla commodo, metus vel egestas pulvinar, eros tellus blandit magna, quis posuere erat eros sit amet est. Vestibulum eget erat ornare quam vulputate cursus. Quisque nec pretium eros. Vivamus in imperdiet dui.

[bookmark: _Toc23835307]CONCLUSIONS

Mauris eros arcu, efficitur vel lectus ut, sodales sodales quam. Maecenas dapibus vehicula diam, et vestibulum lectus condimentum at. Praesent porta in risus id aliquet. In laoreet nec nisl tempus dignissim. Aenean eget nibh sodales, pretium lacus vel, consectetur orci. In hac habitasse platea dictumst. Phasellus eget quam auctor, finibus libero a, ultricies tortor. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam ullamcorper porta ultricies. Sed suscipit elit quis sollicitudin rutrum. Aliquam ullamcorper varius purus non imperdiet.
Morbi dui justo, venenatis eget ex id, mattis semper mi. Nulla euismod turpis eget leo consectetur, quis blandit ligula vulputate. Etiam maximus, nulla ut imperdiet eleifend, ligula mi venenatis mi, a laoreet lectus lectus dignissim sapien. Praesent porta in risus id aliquet. In laoreet nec nisl tempus dignissim. Aenean eget nibh sodales, pretium lacus vel, consectetur orci. Nam scelerisque pulvinar orci, vitae posuere nunc consequat eu. Curabitur est turpis, accumsan quis augue eget, pretium auctor felis. Fusce eget felis fermentum, maximus purus id, bibendum nunc.
Here is an example of another figure, called Figure 3 because it is the third figure within this paper. 

[image: ]
[bookmark: _Toc21330573]Figure 2. Second figure within your second paper.

Integer ornare sem tortor, maximus finibus neque dictum sed. Morbi eu lacus nec mauris aliquet congue. Etiam sollicitudin, ligula vel hendrerit consequat, velit massa facilisis augue, faucibus rhoncus arcu neque quis enim. Aliquam ligula lectus, porttitor vel ligula vitae, dapibus vulputate purus. Suspendisse scelerisque ipsum a eros fermentum, non volutpat tellus luctus. Sed ultricies tellus dui, non aliquam quam feugiat eget. Donec tempus, velit sit amet rutrum elementum, ligula urna suscipit ligula, eu efficitur eros massa a lectus. Pellentesque vulputate mauris vitae congue pellentesque. Proin turpis turpis, vestibulum eget faucibus sit amet, lacinia at ipsum. Nulla a finibus augue, et pharetra neque. 
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Student Name, Joe Smith, James B. Brown, Charles R. Jones, D. F. Lang, and Hardy Davidson
Deparment of Mechanical and Aerospace Engineering, Missouri University of Science and Technology, Rolla, MO 65409
[bookmark: _Toc23835310]ABSTRACT
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Integer iaculis volutpat mattis. Quisque sodales consequat nibh. Phasellus aliquam, erat sit amet ullamcorper laoreet, nibh risus vulputate ante, sit amet fringilla quam mauris eu dui. Ut eget viverra dui. Aenean tortor metus, vehicula in blandit id, tincidunt vitae velit. Maecenas ullamcorper dictum condimentum. Suspendisse id feugiat sapien, sit amet tempor nibh. Fusce in est ipsum. Proin rhoncus risus nec gravida finibus. Nunc lobortis purus eu mauris laoreet convallis. Vestibulum at luctus ex. Maecenas arcu ante, bibendum vel pellentesque non, hendrerit sed nisi. Praesent eget nisi nisi. Phasellus euismod libero in sapien tincidunt imperdiet. Sed nec sollicitudin eros. Vestibulum sit amet dignissim. Est lorem ipsum dolor sit amet consectetur adipiscing elit pellentesque. Tellus elementum sagittis vitae et leo duis. Turpis in eu mi bibendum neque egestas congue. Pellentesque id nibh tortor id aliquet. Lobortis scelerisque fermentum dui faucibus in ornare. estibulum morbi blandit cursus risus at ultrices mi. Laoreet id donec ultrices tincidunt arcu non sodales. Ut sem viverra aliquet eget sit amet tellus. Duis ut diam quam nulla porttitor.
Keywords: Keyword1, Keyword2, Keyword3, Keyword4, etc.

1. [bookmark: _Toc23835311]INTRODUCTION
[bookmark: _Toc23835312]BACKGROUND
Viverra orci sagittis eu volutpat odio facilisis mauris sit amet. Ut enim blandit volutpat maecenas volutpat blandit aliquam etiam erat. Sit amet mauris commodo quis imperdiet massa tincidunt. Diam ut venenatis tellus in metus vulputate eu scelerisque. Cursus sit amet dictum sit amet justo donec. Gravida cum sociis natoque penatibus et magnis dis parturient montes. Felis eget velit aliquet sagittis id. Tempor orci dapibus ultrices in. Tempus egestas sed sed risus pretium quam vulputate dignissim. Nibh sit amet commodo nulla.
[bookmark: _Toc23835313]LIMITATIONS OF STUDY
Augue eget arcu dictum varius duis at consectetur lorem. In nulla posuere sollicitudin aliquam ultrices sagittis orci a scelerisque. Convallis aenean et tortor at. Orci a scelerisque purus semper eget duis. Enim neque volutpat ac tincidunt vitae semper quis lectus nulla. Pretium viverra suspendisse potenti nullam ac tortor vitae. Dolor magna eget est lorem ipsum. Lacinia quis vel eros donec ac.

[bookmark: _Toc23835314]EXPERIMENTAL PROCEDURE

Blandit massa enim nec dui nunc mattis enim ut tellus. Consectetur libero id faucibus nisl tincidunt eget nullam. Urna condimentum mattis pellentesque id nibh. Mauris in aliquam sem fringilla ut morbi tincidunt augue interdum. Porttitor eget dolor morbi non arcu risus. Nulla pharetra diam sit amet nisl suscipit adipiscing. Ultrices neque ornare aenean euismod elementum nisi quis.
[bookmark: _Toc23835315]MATERIALS
Habitasse platea dictumst quisque sagittis purus sit amet volutpat. Urna molestie at elementum eu facilisis sed. Tincidunt eget nullam non nisi est. Parturient montes nascetur ridiculus mus mauris vitae ultricies leo. Placerat orci nulla pellentesque dignissim enim sit amet venenatis. 


[bookmark: _Toc21330574]Figure 1. First figure within your third paper.

Pulvinar pellentesque habitant morbi tristique senectus et netus et malesuada. Id nibh tortor id aliquet lectus proin nibh nisl condimentum. Id semper risus in hendrerit. Tempus egestas sed sed risus pretium quam vulputate dignissim. Amet commodo nulla facilisi nullam vehicula ipsum a arcu cursus.
[bookmark: _Toc23835316]METHODS
Iaculis at erat pellentesque adipiscing. Risus pretium quam vulputate dignissim. Quis risus sed vulputate odio ut enim blandit volutpat maecenas. Non diam phasellus vestibulum lorem sed risus ultricies. Ultricies integer quis auctor elit sed vulputate mi. Risus ultricies tristique nulla aliquet enim. Tristique magna sit amet purus gravida quis blandit turpis cursus. Dictum sit amet justo donec enim diam vulputate. Quis vel eros donec ac odio tempor orci dapibus ultrices. Consequat id porta nibh venenatis cras.
Accumsan tortor posuere ac ut consequat semper viverra nam libero. Orci porta non pulvinar neque laoreet suspendisse interdum.

[bookmark: _Toc23835317]RESULTS

Amet venenatis urna cursus eget nunc. Urna nunc id cursus metus aliquam eleifend mi in nulla. Posuere morbi leo urna molestie at. Suspendisse interdum consectetur libero id faucibus nisl. Bibendum neque egestas congue quisque egestas diam in. Rutrum quisque non tellus orci. Nibh ipsum consequat nisl vel. Ac turpis egestas integer eget aliquet nibh praesent. Tortor consequat id porta nibh venenatis cras sed felis.
[bookmark: _Toc23835318]EXPERIMENT ONE
Nulla aliquet enim tortor at auctor. Purus viverra accumsan in nisl. Massa massa ultricies mi quis. Ac ut consequat semper viverra nam.
[bookmark: _Toc23835319]Qualitative Data.
 Sed elementum tempus egestas sed sed risus pretium quam. Ac felis donec et odio. Euismod in pellentesque massa placerat duis ultricies lacus sed. Amet cursus sit amet dictum sit amet justo donec enim. Vitae semper quis lectus nulla at volutpat diam ut venenatis. Ultricies tristique nulla aliquet enim tortor at auctor urna. Leo vel fringilla est ullamcorper eget nulla facilisi etiam dignissim. Montes nascetur ridiculus mus mauris vitae ultricies leo integer malesuada. 

[bookmark: _Toc21330719]Table 1. First table within your third paper.
	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	



[bookmark: _Toc23835320]Quantitative Data.
 Donec ultrices tincidunt arcu non sodales neque sodales. At erat pellentesque adipiscing commodo elit at. Nullam eget felis eget nunc lobortis mattis aliquam faucibus purus. Senectus et netus et malesuada fames. Ac odio tempor orci dapibus ultrices in iaculis nunc. Enim nulla aliquet porttitor lacus. Libero id faucibus nisl tincidunt eget nullam non nisi. Ut eu sem integer vitae justo eget magna. Senectus et netus et malesuada fames. Sodales neque sodales ut etiam sit amet nisl purus. In mollis nunc sed id semper risus.
Sit amet justo donec enim diam vulputate. At tempor commodo ullamcorper a. Nulla malesuada pellentesque elit eget. Nam at lectus urna duis convallis convallis tellus id. Amet volutpat consequat mauris nunc. Donec pretium vulputate sapien nec sagittis aliquam. Id faucibus nisl tincidunt eget nullam non. Leo in vitae turpis massa sed elementum tempus egestas.
[bookmark: _Toc23835321]Discussion. 
 At erat pellentesque adipiscing commodo elit at imperdiet dui. Id volutpat lacus laoreet non curabitur gravida arcu. Suspendisse sed nisi lacus sed viverra tellus in. Tempus imperdiet nulla malesuada pellentesque.
[bookmark: _Toc23835322]EXPERIMENT TWO 
Eget egestas purus viverra accumsan in nisl. Convallis convallis tellus id. 
[bookmark: _Toc23835323]Qualitative Data.
 Fringilla phasellus faucibus scelerisque eleifend donec pretium vulputate sapien nec. Blandit cursus risus at ultrices mi. Magna fermentum iaculis eu non diam. Est sit amet facilisis magna etiam. Magna eget est lorem ipsum. Posuere morbi leo urna molestie at elementum eu. Habitant morbi tristique senectus et. 
[bookmark: _Toc23835324]Quantitative Data. 
 Malesuada proin libero nunc consequat interdum varius sit amet mattis. Curabitur vitae nunc sed velit dignissim sodales ut eu. Sit amet risus nullam eget. Faucibus turpis in eu mi bibendum neque. Lacinia quis vel eros donec ac. Velit scelerisque in dictum non consectetur.
[bookmark: _Toc23835325]Discussion. 
 At erat pellentesque adipiscing commodo elit at imperdiet dui. Id volutpat lacus laoreet non curabitur gravida arcu. Suspendisse sed nisi lacus sed viverra tellus in. Tempus imperdiet nulla malesuada pellentesque.

[bookmark: _Toc23835326]CONCLUSIONS
[bookmark: _Toc23835327]CONCLUSIONS AND FUTURE WORK
Tortor consequat id porta nibh venenatis cras sed felis. Neque ornare aenean euismod elementum nisi quis. Nunc vel risus commodo viverra maecenas. Id donec ultrices tincidunt arcu non sodales neque. Tortor vitae purus faucibus ornare suspendisse sed. Elit duis tristique sollicitudin nibh sit amet commodo nulla facilisi.
[bookmark: _Toc23835328]FUTURE WORK
Et malesuada fames ac turpis egestas sed tempus urna et. Non pulvinar neque laoreet suspendisse interdum consectetur libero. Metus aliquam eleifend mi in nulla posuere sollicitudin aliquam. Commodo viverra maecenas accumsan lacus vel facilisis volutpat est velit. Scelerisque viverra mauris in aliquam sem. In pellentesque massa placerat duis. Feugiat pretium nibh ipsum consequat. A arcu cursus vitae congue mauris rhoncus aenean. Tincidunt ornare massa eget egestas purus viverra accumsan. Neque vitae tempus quam pellentesque.

[bookmark: _Toc23835329]REFERENCES
Bucki, L. (2013). Microsoft Word 2013 bible (4th ed.). Indianapolis, Ind: John Wiley & Sons, Inc.
Gookin, D. (2015). Word 2016 for dummies. Hoboken, NJ: John Wiley & Sons, Inc.
Haselier, R. G. (2013). Microsoft Word 2013: Die offizielle schulungsunterlage. Köln [Germany]: Microsoft Press.
Knauff, M., & Nejasmic, J. (2014). An efficiency comparison of document preparation systems used in academic research and development. Plos One, 9(12). doi:10.1371/journal.pone.0115069
Lambert, J. (2015). Microsoft Word 2016: Step by step (1st ed.). Redmond, Washington: Microsoft Press, a division of Microsoft Corporation.
Lambert, J., & BarCharts, I. (2016). Microsoft Word 2016. Boca Raton, Florida: BarCharts, Inc.
Marmel, E. J. (2015). Office 2016 simplified (1st ed.). Indianapolis, IN: Visual a Wiley Brand.
Pierce, J. (2016). MOS 2016 study guide for Microsoft Word expert: Microsoft Office specialist exam 77-726. Redmond, Washington: Microsoft Press.
Rose, A. (2016). Microsoft Word in 30 minutes: How to make a bigger impact with your documents and master Word's writing, formatting, and collaboration tools. Newton, Massachusetts: i30 Media Corporation.
Rutledge, P. (2016). Easy Office 2016: See it done, do it yourself. Indianapolis, Indiana: Que.
Stone, W. R. (2017). Converting between TeX or LaTeX and word [from the screen of stone]. IEEE Antennas and Propagation Magazine, 59(4), 121-123. doi:10.1109/MAP.2017.2706673
Wempen, F. (2015). Word 2016 in depth (1st ed.). Indianapolis, Indiana: Que.
Wempen, F., & John Wiley & Sons. (2015). Microsoft Office 2016 at work for dummies. Hoboken, NJ: John Wiley & Sons.


SECTION
1. [bookmark: _Toc23835330]CONCLUSIONS AND RECOMMENDATIONS
[bookmark: _Toc23835331]CONCLUSIONS 
This is where you will resume your SECTION writing. This section is required in the Publication Option. Make sure that your numbering restarts where you left off before the PAPER writing. You can do this by right-clicking the heading number and choosing “Set Numbering Value.” If you 3rd and 4th level heading numbers change, try highlighting them and pressing Ctrl + Space.
[bookmark: _Toc23835332]Third Level Heading. 
 Ut aliquet lacus ac fringilla convallis. Morbi laoreet at turpis non elementum. Integer condimentum, ligula eu posuere euismod, lectus ipsum viverra elit, ornare nisi libero.
[bookmark: _Toc23835333]Second Third Level Heading.
 Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; Fusce vitae sapien sit amet lacus ornare pharetra vitae sed turpis. Mauris feugiat eleifend accumsan. A Sed elementum sapien vel scelerisque dignissim. Nunc cursus mattis leo, vitae laoreet nisl euismod vitae.
[bookmark: _Toc23835334]RECOMMENDATIONS
Fusce nec diam eu felis maximus ultrices. Quisque suscipit mollis nunc id iaculis. Fusce ut iaculis risus. Pellentesque laoreet risus a neque lacinia, ut vestibulum erat lobortis. Integer scelerisque fermentum nulla sed molestie. Sed eu ex vitae ex sollicitudin efficitur. Pellentesque hendrerit non mi quis condimentum.
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Click on the rectangle placed over the page number and change Shape Outline to “No Outline” under the Drawing Tools Format Tab. Now you can place the rectangle such that it hides the page number.


[bookmark: _Toc419149491][bookmark: _Toc419151462][bookmark: _Toc415853988]APPENDIX A.
[bookmark: _Toc23835335]TITLE OF FIRST APPENDIX


Put your appendix information here. Note that the format used here is for a T/D that has more than one appendix. The format for this is each appendix must have its own title sheet with the word APPENDIX, in uppercase letters, followed by an uppercase letter and centered on the page. You should then have two blank lines and then the title of the appendix in uppercase letters. Do not include a page number on the appendix title page, though it is counted in the overall page count. 
For a T/D with a single appendix, the word APPENDIX must be centered at the top of the page and the material should start on the same page. Note that there is NOT a letter distinction for this type. An example of a single appendix is shown on the thesis template. Use Heading 0 for “APPENDIX” and Appendix Title (1) for the title.
If you have multiple appendices, they will have to be manually adjusted in the TOC.  The titles will link automatically, but you must type in “APPENDICES” on the line before them, and write in the corresponding letter beside each title. 
Page number should not be present on appendix title pages. You can do this by inserting section breaks before and after, then unlinking the page number to previous pages and selecting “remove page number” from the appendix title page. Another easy way to do it is to draw a white rectangle without a border over the page number, as shown in the previous page.
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[bookmark: _Toc419149493][bookmark: _Toc419151464]APPENDIX B.
[bookmark: _Toc23835336]TITLE OF SECOND APPENDIX


[bookmark: _Toc419149496]You may want to put large figures or tables within your appendix rather than in the middle of your main body. Note that you can turn a page landscape for a figure or table, but your page number should be in the same spot as your other pages when the page is turned back to portrait. In other words, Word’s automatic readjustment of page numbers on landscape pages will be incorrect. You will need to manually readjust the page number, or keep the page portrait and turn your figure sideways.
To turn a figure sideways: click the figure, then drag the arrow until it is in the right position. Note that this does not work for tables and graphs. You can insert a table or graph into a text box, turn the text box sideways, and then remove the border, but note that this will likely cause the program to slow if done multiple times. Instead of turning a table sideways, you could also change the text direction within the table. 
To turn a page sideways: insert a section break before and after the page. It is easiest to put a box over the current page number (be sure to remove the border) and then insert a text box with the page number written in, then turn the text box sideways where the page number should be. Note that you will manually have to update the page number you have written in if the page location shifts.
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[bookmark: _Toc523393445][bookmark: _Toc2865541][bookmark: _Toc21330720]Table B.1. Formatting a Landscape Table. a) Turning a Table Sideways (p. 38). b) Turning a Page Landscape (p. 39).
COLUMN A
ROW 1
COLUMN B
COLUMN C
COLUMN D
COLUMN E
ROW 2
2B
2C
2D
2E
ROW 3
3B
3C
3D
3E
ROW 4
4B
4C
4D
4E
ROW 5
5B
5C
5D
5E
ROW 6
6B
6C
6D
6E



[bookmark: _Toc523393446][bookmark: _Toc2678144][bookmark: _Toc2855659][bookmark: _Toc21330721] Table B.1. Formatting a Landscape Table. a) Turning a Table Sideways (p. 38). b) Turning a Page Landscape (p. 39). (cont.)Word automatically places your page number here when turning the page landscape

	COLUMN A
ROW 1
	COLUMN B
	COLUMN C
	COLUMN D
	COLUMN E

	ROW 2
	2B
	2C
	2D
	2E

	ROW 3
	3B
	3C
	3D
	3E

	ROW 4
	4B
	4C
	4D
	4E

	ROW 5
	5B
	5C
	5D
	5E

	ROW 6
	6B
	6C
	6D
	6E


This page number must be manually updated if page location changes
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Double spacing should be used between each reference. References that are more than one line long should be single-spaced within. References can be formatted alphabetically (with hanging indent) or numerically. Students may use the citation style recommended by their department, or otherwise use whichever style best suits their area of study. APA and IEEE are commonly used at Missouri S&T. Remove the blue text and underlines from your hyperlinks.
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Provide information about yourself here. You must include your full legal name, Joseph Edward Miner. For privacy reasons, including your date of birth is not required. All degrees earned and year earned need to be included in the vita. Also include the degree and date of the current degree earned. The vita should be written in past tense.
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